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 What Is PSK?

© 2013 Eric Fowler / WV3E — All rights reserved. \

PSK is an acronym for Phase Shift Keying. Information is transmitted
through patterns of polarity-reversals (180 degree phase shifts), hence the
name.

Narrow-band, low-power, soundcard-generated radioteletype mode for
keyboard chat.

Three data rates, 31, 63 and 125 baud. Bandwidth increases with rate.

PSK31 is the most commonly used, its data rate is close to the speed of the
average typist.

PSK is resistant to interference but has no error control, so it's not suitable
for transfer of data files.
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 Hardware Prerequisites

- Radio

« For rig control, see the list of supported radios at:

http://forums.hrdsoftwarellc.com/archive/index.php/t-23332.html

- QRP is okay, but typical operating power is up to 30 watts

- PSK is continuous duty — be kind to your finals

- PSK can be sent and received with boat anchors, but frequency stability
IS an issue and it complicates automated logging

- Antenna
* Pretty much anything goes, the more efficient the better

)

»
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 Computer Hardware

- Recommended

e Desktop or laptop PC
Dual-core processor

4 GB RAM memory

50 GB free disk space
1920x1080 color display
Windows 7

© 2013 Eric Fowler / WV3E — All rights reserved.

— Minimum

Desktop or laptop PC
Pentium 5 processor

1 GB RAM memory

10 GB free disk space
1024x768 color display

Windows XP SP3*
*Support ends 4/8/14

»
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 Other Hardware

- CAT, CI-V or serial cable for rig control

« Consult your radio's User Manual for specifics

» Steer clear of unbranded USB-serial adapters
- Market flooded with Chinese counterfeit Prolific chips with poorly-written drivers

- Sound card interface
« SignaLink USB  http://www.tigertronics.com *this presentation is based on this product*

- Requires an interface cable for your specific radio. See website for details.
» Rigblaster http://www.westmountainradio.com

 Home-brew cables using PC sound card
- Beware of ground loops, they can cause distortion. An isolated interface is preferred.

* Not required for certain radio models with a built-in USB interface

* |[com IC-7200, IC-7410, IC-7600, 1C-9100
« Kenwood TS-590, TS-990
 Yaesu FTDX-3000 ‘
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e Software

- Drivers for USB to serial or CI-V adapters or USB
Interface for certain radio models

- Ham Radio Deluxe http://www.hrdsoftwarellc.com

* Version 6.0 $99.95 yearly support subscription
» Versions 5.24.38 and earlier $FREE
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e Setup

- Install drivers for USB to serial or Cl-V adapters or USB
Interface for certain radio models
e Consult the User Manual for your specific equipment

- Drivers for the SignalLink USB are included with Windows
XP, Windows Vista and Windows 7, just plug and play

- Install Ham Radio Deluxe -
e This tutorial is based on version 5.24.36, version 6.0 IS similar.
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» Connecting the Rig Control Cable
- CAT, CI-V or serial cable between the rig and the PC
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 Installing the SignaLink Jumpers

- Configures SignaLink for rig-specific interface cable
- See the manual or http://tigertronics.com/sl_wire.htm

5

© 2013 Eric Fowler / WV3E — All rights reserved. \


http://tigertronics.com/sl_wire.htm

Operating PSK With Ham Radio Deluxe

* Connecting the SignaLink
- Rig-specific cable between the radio and SignaLink
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* Connecting the SignaLink cont'd

- USB cable between the SignaLink and PC
 Drivers are inculded with Windows and will install automatically

© 2013 Eric Fowler / WV3E — All rights reserved.
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=5 o Start Ham Radio Deluxe

- The first time HRD is started the
Connect window appears

“) Connect: Unregistered - Registration is FE -

| Mew Precet Serial Ports Help

. — ] - Select your rig's make and model

OMparny: ErWon - Status

Radc: 752000 . - Auto detect will scan all COM ports and
standard baud rates

COM Pt (Autadetec 1 - Set the checks at the bottom however

Speed |Auto-detect | you prefer. Logbook and Digital Master

B are both needed for digital modes

S we ~ Click Connect. When HRD finds the rig -

it will connect automatically and open

the rig control window

Always connect to thiz radio when starting HRD Start: Digital M azter 780
[] Start HRD in Full Screen mode Logbool,
[] Ratatar
[ Satelite Tracking ‘
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5] HamRadi T5-2000)

File Edit View Bands Favorites QuickSave Macros Logbook Scanning Tuning Window  Help
[ =5 - A
S L ’ A 58

e U On SuCCeSSfuI
1 ¥
\ ) - — \j5a ! -
Connect Selection Favorite Quick Save | Full Screen Logbook Satellites SW Data || Sliders | Customize Options Forums . Add . DM780 Synch Remote Serial Programs . - -
T5-2000 X
Main busy ‘vroa (cH+ ‘67Hz [muo [comp [Fne [ pre | Mose uss |

'vFoB [ cH- “ar (B (omm ‘wec [ mi [ RXFiter |

14.070.000 S control window displays

the VFO frequencies
and available controls
for your radio model

Main | B=A 5

28.480.000

‘antz cal [ExB [Notcn Sub-RX

Sunday, April 21, 2013 160m - 10m (Region 1

- AF gain (main): 26 et AF gain (sub): 0 RF gain: 100 - RF power: 100 W -

ABC constant 2

Squelch {main}: D Squelch (sub): 0 Micigain: 10

W DSPow cut: 200 Hz

Noise blankersgs Moise reduction: 0

DSP high cuts2600 Hz
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(5 st =] « Setup HRD Logbook

- Open HRDLogbook
[ Atomaticaly opy Prfle 1 o Contest Mads Log eirs - Select Configure...My Station

wew [ 2 [ 3 [ 4 [ 5 [ 6 [ 7 [ 8 3 [ 10 [Gues|

Calsign:  |W3EXW SIG: | |

Owrer:  |NHARC SiGinfo: | | minimum, enter yOUI’ Ca”Sign
Operator: WY3E Locator:

Values

— Configure as desired, at the

- Explore the other options

Name: Latiude: 40573446 |

suse Longiude: [-79.961547 | under the Configure menu
= come & ] mfi

County: Power:  [100 | watts

State: I0TA: | [=]]

zIP; Courtry  |United States

Equipment: |Kenwmd TS5-2000

Antennas: |Fnlded Diploe, Buddipole \

Club: |Nurth Hills Amateur Radio Club bitp:/ fwww nharc.ong ‘ ‘
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Getting Started  Set up Digital Master 780

1-2-3-4-GO
sl e 5 sy e you o 1 v el dfed 1 your 565 windon - Open DM780. Upon first
(1 Tags (Callsan, Nome, ) R run, the Getting Started
X Gl hre to diplay the Tags window. screen is displayed

Calisign i@y Enter values in the Tags window, these values are used in macros

;{: (50). The values are saved automaticaly. o e Yo haves — This screen includes links
Q_TH_l L‘?a“ ; Put your own callsign in the About Me: Callsign field. t th .
e et O the minimum

Clubz EPC 1114

i configuration options

distance and bearing cakulations

o v required to use DM780

(2) Soundcard

k Click here to select your soundcard or press F8 to display the Program
Options (or select Program Options from the Tools menu) and select the
Soundcard page.

© 2013 Eric Fowler / WV3E — All rights reserved. \
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« Getting started with DM780

Appearance Q50 Tags l
Callsign (My Info) | ]
Clock =/ About Me [i <- Put your callsign in the "About Me: — Confl ure Ta S
Loghook Callsign W3EKW Callsign’ field.
M Eri V3E
Modes + IDs ame ic (WV3E) Enter values in the Tags window, these values

PTT Age 50 are used in macros (shortcuts which save you ) Cal ISig n , name . age’

Locator EM30xn entering the same text every time you have a

Radio ; s0). . .
aso S = Maidenhead, QTH, email,

The values are saved automatically.
Seundcard HomePage www.nharc.org

Sounds g e home page, club affiliation

Storage I=' My Equipment

Supersecper fade _ evene T2  Radio, antenna, transmit

Folded dipole, Buddipole

Al e [y T power, computer, interface,
e, e accessories

Medes... |- Other
Mavigator... Temperature °
enthe WX, etc
Audic Recorder... Otherl
PSK Reporter... Other2 A
Soundcard Calibration... Other3
Time Synchrenisation.., Otherd
= Computer M
Callsign .
Your callsign ‘
[ @  Getting Started | ‘
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Appearance
Callsign {My Infa)
Clock

Logbook

Modes + IDs

PTT

Radio

Q50

| Soundcard

Sounds
Storage
SuperSweeper
Waterfall

Alarme...
Favorites...
Macros...
Modes...
MNavigator...

Soundcard l

Input {Receive)

Device: | Microphone (3- USB Audio CODEC )

daja

Output (Transmit)

Device: | Speakers {3- USB Audio CODEC )

U

Output (Transmit)

@0dE (O25dB (5B (O 10dB O 1548 (O 20dB

[] Show sample rate in main status bar

[ Show Supported Formats ]

Audic Recorder...

PSK Reporter..
Soundcard Cahbration...
Time Synchronisation...

| @  Getting Started

|

[ Soundcard Calibration ]

For recording and playback of wave files see: Recording

Input (Receive)

Device: Select the soundcard used
for receiving signals, the line in is
connected to the audio output from
your radio.

Source: Select the input source -
usually Line in. This fader is shown
in the soundcard's RX pane, use it
to adjust the input level. Not all
soundcards have input sources - for
example the SignaLink USE does
not have any user-selectable input
sources.

Output (Transmit)

Device: Select the soundcard used
for transmitting signals, the speaker
output is connected to the audio
input on your radio. This is normally
the =ame as the input device.

Source: Select the output source -
usually Wawve. This fader is shown in
the soundcard's TX pane, use it to
adjust the output level.

Output Attenuation

If yvour radio is very sensitive apply
output attenuation here, it makes
use of the faders much sasier.

Show sample rate...
Shows the current effective sample
rate in the_ main status bar, this is

(]
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e Getting started with DM780

- Configure Soundcard

Set input device to
Microphone (USB Audio
Codec) for SignalLink

Set output device to
Speakers (USB Audio
Codec) for SignaLink
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o Pane T5200 * Getting started with DM780

R0 s [fizgize Connect to HRD User Interface &)

Addresz: | localhost . .
- | | - Configure Radio Interface
ort: PBDS | Ham Radio Deluxe:
[#] Automatically connect h i /1P - h
[ T * Use the default Address and
Connect
2 commecet to 2 tad (veu must uee bula |- Port for HRD on your PC
I - Mode l I - Rt Filter 1317 or later). ]
[-_ahiien_] [=__sen > In D slectIo server from e ke e, * Check the Automatically
I - \arious l I - connect to the IP Server).
I l [ ] I Configure Radio Pane: ConneCt bOX
| T = = .
e e e e * Click Connect to test the
localhost (or 127.0.0.1) can usually be used to .
I = l [ = ] I = connect to the local computer, the actual Connectlon

network address is shown in the IP Server

|
|
|
|
|
|
e | e | prw— windon: . -
l Do NOT enter the address of the HRD - HRD must be runnlng and .
|
|
|
|
|

I —— Remote Server, always use the HRD User . .
== Tt g vou amere oo o R RO connected to a radio or in
User Interface.
—— d d
: 2 Paort - the default port is 7809, use the same port emo m 0 e
—— selected in the IP Server window. .
I —— 3 Always connect to HRD - if checked an attempt is ° CI ICk Sa Ve
made to connect to HRD when the program
I —— starts even if not connected when the previous lﬂ _
M
I ol Save l [ @ Help ] | & FTT - Select 'Program Dptions' from the 'Tools' menu | '

© 2013 Eric Fowler / WV3E — All rights reserved. \
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giang * Getting started with DM780
Appearance PTT ]
Callsign (My Infe) COM P Ham Radio Del Riadio Operations C .
Clock ort am Radio Dele angt F{%e[ﬁtqlon:h:mer _ CO nfl u re PTT
ey
Logbook () via Serial {COM) port "y via Ham Radio Deluxe - DM780 radio via inteface.
must be connected to HRD.
Modes + IDs Port: | CO . . .
PTT Corfigure HRD connection Mone ° S L k U S B d
Radio On T 34teminal-ready ® via soundcard Igna In prOVI eS
) B smoosebaor LT soundcar use the
050 s dcard PTT h
Soundcard !
Sounds COM Port ] N I
Storage To use a COM port for PTT: One Optl On
Supersweeper »  Select via Serial (COM) port t t
Waterfall » Select the COM port; this must not be in use by another program, [ J O h p
v Select DTR, ARTS or DTR and RTS. er O IonS are

Alarme... : : 1 1

When you switch to TX DTR and/or RTS are =set (raised), when you return to RX they are I bl f d ff
available for different
M
MZ?::... MNote: 'ghis port cannot be used by another program such as HRD - it must be available for = hardware

exclusive use by DM780.
Mavigater...
Audio R 4 Ham Radio Deluxe

Udio Recorder... To use HRD the radio pane must be connected to HRD:
PSK Reporter...
- : + In the View menu select Radio

S?undcard CE|I.brEt.IDI'1... + In the Radio pane press Configure and read the instructions!
Time Synchronisation... » The Radio must be able to support the TX command in it's CAT control.

Note: If yvou use Ham Radio Deluxe for PTT and yvou connect the audio via a rear b |

connector {not the microphone connector) make sure your radio will accept audio via the

rear connector when using FTT via a software command, some radios such as the TS- i

2000 will not? u ‘
- w

| @  GettingStarted | ‘
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* \Working with macros

© 2013 Eric Fowler / WV3E — All rights reserved. \

Macros are scripts for common tasks such as calling CQ, making
a signal report, and bidding farewell

Macros use stored variables and commands to automate
common tasks

Macros can be used in conjunction with the keyboard for
ragchewing

Macro text can be edited 'on the fly' before it is transmitted
Macros simplify routine contacts
Macros are useful for contesting
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* Personalizing the macros

- The default macro set cannot be edited

- Copy the defaults to one of the other available sets, then
rename and edit the set to suit your taste

- Up to eight different sets of custom macros can be made
for different operating scenarios

© 2013 Eric Fowler / WV3E — All rights reserved.
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« Editing Macro Set 3

P Ba T B

e import~ Defauits Load - - Set 3 is initially empty
Macroz zet | Set 3 M [ISetTitle ] B CIICk Import
Ena.. Gro.. T.. Tool. Moo Definition - SeIeCt Replace 'Set 3' Wlth 'DefaUIt'

_

@ Import Macro Definitions

Either replace the 'Set 3' definitions with the 'Default’
definitions, or add the 'Default’ definitions to the 'Set 3°

definitions.
i (%) Replace 'Set 3' with 'Default’
Appearance M acroz Pane Firzt M ame
- Add 'Default’ to 'Set 3'
Toolbar: () Buttons (%) Popups Organize by group [] 5end his first name only {}
) [the hiz:name tag)
|cons: Send Imrmediately Shov macio set title

[] Eraze T window
Radio Contral

(] ] [ Cancel

© 2013 Eric Fowler / WV3E — All rights reserved.
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= Macros Manager *

B

Mew

CallCQ Reply Info Closing

]
call cQ £
P cQx2
P CQx3
b QRZ

r

Reply

1) Him de Me

2) Him de Me Pse
K

3) Report, Mame,
QTH
4) Station

Info

5) MFSK Ficture

I ] l [ Cancel

B2 7 b H

Import = Defaults Load Save As

M acros set; | Mormal

lv| | setTite ]

Ena.. [Group Title Taoalbar Ma...  Definitian
CalCO CQ=2 CQx2 * CO CO de <my:callsign: <mwcallsigr
CalC Cd=3 co * LG CO de <my:callzsign: <my:callsigr
CalCO QRZ GQRZE * [RZ ORZ QRE de <my:callzign: <m
Reply  Him de Me Him de ke * <hiz:callzign: de <my:callzign:
Reply  Him de Me Pze K Him de ke - K * <hiz:callzign: de <mycallzign: <my:c
Reply  Repat, Mame, QTH  RST,Mame, ATH = <hizcallzigny de <mywcallzigne niaH
Reply  Station Statian * <hiz:callsigny de <mycallsignsning
Info MFSE. Picture kFSE Pic * Here iz a picture <zend-pic| do thIM
'_| loaio | [N N RN g T By - | IR o R £ S e s b S o ¥ e |
4 11} ] [i]
Appearance M acroz Pane Firzt M ame
Toolbar: () Buttons (%) Popups Organize by group [] 5end his first name only
) [the hiz:name tag)
|cons: Send Imrmediately Shov macio set title
[] Eraze T window
Radio Contral

© 2013 Eric Fowler / WV3E — All rights reserved.

Editing Macro Set 3 cont'd

- Set 3 is now populated with the defaults
- Click Set Title, then enter a new name

- Edit and Enable macros as desired

Enter a new walue for thiz macro get, then press '0OF.

| Harmal |

L_oc |

Cancel
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* \Working contacts with macros

- Calling CQ
e Ctrl+1 = call twice
o Ctrl+2 = call three times
e Ctrl+3 = QRZ?

- Answering a call

e Ctrl+4 = Him de Me (useful for ragchewing)
e Ctrl+5 = Him de Me Pse K

© 2013 Eric Fowler / WV3E — All rights reserved. \
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* \WWorking contacts with macros cont'd

- Reports
« Ctrl+6 = signal report, name, QTH, location
e Ctrl+7 = station information
- Info
o Ctrl+8 = weather
- Closing
o Ctrl+9 = BTU (useful for ragchewing)

e Ctrl+0 = 73 (sign with the station and add the contact to th
a

»

© 2013 Eric Fowler / WV3E — All rights reserved. \
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Demo time, let's make some contacts!

© 2013 Eric Fowler / WV3E — All rights reserved. \
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Questions and Answers

© 2013 Eric Fowler / WV3E — All rights reserved. \
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Thank You!
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